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Safety Information

WARNING! Use of procedures or adjustments other than those specified herein may result in hazardous radiation
exposure.

1650 nm SM OTS/OLS/OPM port This is a CLASS | LASER output.

VFL port This is a CLASS Class 3A / Class 3R LASER output.
Avoid exposure to the beam!

NOTE! FlexScans equipped with Bluetooth (option W1) contain the following Bluetooth Transmitter Module:

FCC ID: X3ZBTMODS8
IC: 8828A-MOD8

NOTE! FlexScans equipped with Wi-Fi contain the following Wi-Fi Transmitter:

FCCID: 2ANTH-FS2TS1

This device complies with Part 15 of FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by AFL Test and Inspection could void the user's authority to
operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause
harmful interference in which case the user will be required to correct the interference at his own expense.

IC: 23261-FS2TS1

This device contains license-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and Economic
Development Canada’s license exempt (RSS(s). Operation is subject to the following two conditions: 1. This device
may not cause interference. 2. This device must accept any interference, including interference that may cause
undesired operation of the device.

L'émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR d’Innovation,
Sciences et Développement économique Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes : 1. L'appareil ne doit pas produire de brouillage; 2. L'appareil

doit accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d’en compromettre le
fonctionnement.

WARNING! Use only the specified AC adapter. Use of another type of AC adapter can damage the instrument and
create the danger of fire and electrical shock.

WARNING! To avoid the danger of fire and electrical shock:

» Never use a voltage that is different from that for which the AC adapter is rated.
» Do not plug the unit into a power outlet that is shared by other devices.

» Never modify the power cord or excessively bend, twist, or pull it.

Do not allow the power cord to become damaged.
» Do not place heavy objects on the power cord or expose it to heat.

Never touch the AC adapter while your hands are wet.

Should the power cord become seriously damaged (internal wiring exposed or shorted), contact the
manufacturer to request servicing.

« CAUTION! Do not run any tests or perform functions that activate a FlexScan laser unless fiber is attached to the
corresponding port.

CAUTION! To avoid serious eye injury, never look directly into the optical outputs of fiber optic network
equipment, test equipment, patch cords, or test jumpers. Refer to your company’s safety procedures when
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working with optical systems.

» NOTICE: Except user replaceable battery, FlexScan contains no user-serviceable parts, it must be returned to AFL
or authorized agents for repair and calibration.

o IMPORTANT: Proper care in handling should be taken when using any precision optical test equipment.
Scratched or contaminated optical connectors can impact the performance of the instrument. It is important to
keep the dust caps in place when the unit is not being used.

o IMPORTANT: Always clean OTS/OLS/OPM port and any mating connectors using approved cleaning supplies (e.g.
One-click cleaner) before mating the connectors.

» CAUTION! Power levels in excess of +10 dBm may damage OTS/OLS/OPM optics. Do not connect FlexScan to
network connectors where received power level may exceed +10 dBm. If high power levels are suspected, verify
power level by connecting to OPM and measuring received power level.

Apple Inc. Legal Notice

AirPlay, iPad, iPhone, iPod, iPod classic, iPod nano, iPod touch, and Retina are trademarks of Apple Inc., registered
in the U.S. and other countries. iPad Air, iPad mini, and Lightning are trademarks of Apple Inc.



Labeling and Hazard Warning

1. 'Laser Radiation' label - located on the back of the TS100 unit.
2. Laser safety warning - silkscreened on the back of the TS100 unit.

3. Serial Number label - located on the back of the TS100 unit.
4. Calibration void label - located on the back of the TS100 unit.

MODEL TSWOO 7OBA Assembled
n Lithuar

2J28YK00001
F ren&lnspem 5

www.AFLglobal.com

Designed and Qual nyA sured i mheUSA
This product complies with 21 CFR
1040.10 and 1040.11 except for deviations
pursuant to Laser Notice No. 50, 6/24/07

Contains Transmitter
Module + MFi

FCC ID: X3ZBTMOD8
IC: 8828A-MOD8




Hardware Overview

Controls, Display, Interfaces

Ref | Feature Description
Power button Press to power FlexScan on/off.
Power port (5 VDC) This is interface for the AC power adapter/charger.
AC/Charger indicator Illuminates when AC is connected and indicates battery charging status.

« RED light = rechargeable battery is charging.
« GREEN light = rechargeable battery is fully charged.
» Flashing RED/GREEN = Battery charging halted due to over-temperature.

4 USB host port This USB port may be used to connect USB Flash Drive for data storage,
results backup or to update FlexScan software.

5 Micro-USB function port With the supplied USB cable, this port may be used to connect TS100 to a
USB host port on a PC to upload stored results, PDF printouts and captured
screen images.

6 1650 nm OTS/OLS/OPM This is a CLASS | LASER output. Used for the following testing:

Port « Live fiber detection and power measurement.

« Detection of faults and other events to end of point-to-point network or
to first splitter in FTTH PON

» Link Length, Loss, and ORL measurements

7 VFL port This is a Class 3A / Class 3R LASER output. Avoid exposure to the beam!
The VFL (visual fault locator) port is a 635 nm (visible red) laser. Used for
short-range fault-location.

Touchscreen display 4.3" 480 x 272 color backlit LCD touchscreen.
9 Home/Menu button » Press to toggle between Test Results Home screen and the Home Menu.
» Press to select Save, Send, or General Settings.
10 Test Start/Stop button Press to start a new test; or, if a test is running, stop the current test.
1 VFL button Use the VFL button to control the VFL laser:

Press and hold ~ 1 sec to enable VFL at ~2 Hz flash rate
Press and hold ~ 2 sec = CW
Press and hold ~ 1 sec to switch off

12 VFL indicator When the VFL port is active this indicator illuminates as follows:
Flashing RED = VFL flashing at ~2 Hz rate

Solid RED = VFL on CW

OFF = VFL is off




Battery Charging
You may charge the battery while your FlexScan is switched on or off by attaching the supplied AC charger.
e Plug the included AC charger into AC outlet.
» Connect charger plug to the Power port.
» AC/Charger indicator will illuminate to indicate charging status as follows:
—RED - Charging battery
—GREEN - Fully charged
— OFF - AC disconnected
—Flashing RED/GREEN = Battery charging halted due to over-temperature.
 FlexScan charges while operating.
o A fully-charged battery operates for approximately 12 hours of typical use.

Understanding Battery Charge Status
When FlexScan is ON, battery icon shown on the display indicates battery status as follows:
B - Battery fully charged
I} - Battery partially charged
- Battery nearing empty
[} - Battery discharged
- Battery charging

Battery fully charged, Battery partially charged, and Battery discharged symbols will only be shown when unit is
operating without being connected to AC.

Configuring FlexScan to Auto-Off

The Auto-Off feature is available for conserving battery power on your FlexScan.

To Configure the Auto-Off Timer:

o Turn your FlexScan On.

» From the displayed Home screen, press Home/Menu button to display General Settings menu.
« In the Settings menu, locate the Auto Off Timer option.

» Touch the Auto Off Timer field to display the settings sub-menu.

« Select the desired power save option (Never, 5 min, 15 min).

£+ Settings - General

Auto Off Timer Launch Quality Check 13
Cf 16 min C @
Remote Control Received Image ‘
f/—_' ) Popup Window
Switch Mode Auto-Save & Send
Auto Disabled




User Interface Overview

New Test - FlexScan’s Home Screen

The New Test screen is the FlexScan’s main screen that is displayed at startup.

A New Test 00:03
RX Power Link Loss | Link ORL Press
1490 nm [ | 15501577 [ | 1650 1650 'rl.
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@
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From the New Test screen you may perform the following setup and operations:

1. Press Home/Menu button to display the Test/Home Menu screen and select Save, Send, or configure General
Settings.

Press Start/Stop button to enable Live Fiber check, or to start a new test, or (if test is running) to end a test.
Press VFL button to enable VFL mode.

Touch Tool icon to configure Test Settings or select OLS/OPM or Inspection.

Touch Launch Cable to change LC length.

o vk~ wN

Touch Network to configure Network Type: Pt-to-Pt or FTTH PON and expected split ratio.



Test/Home Menu Screen Overview

1. Test/Home Menu screen may be accessed from the Test Results/Home screen by pressing the Home/Menu
button, or from the LinkMap screen by touching the 3-bar Menu icon.

While in Test Home Menu screen, you may perform the following operations:
2. Touch Save As to name and save results.
3. Touch Send To option to send results to Bluetooth-paired device.

—If Send To option is grayed out, Bluetooth is either not available or disabled. Select General Settings to enable
Bluetooth and pair to mobile device running the FlexScan App if you wish to upload results to that device for
reporting or sharing.

Touch General Settings to select, view, and edit General Settings.
Touch My Projects to recall and view saved results.
Touch USB icon to enter USB upload/download mode.

Touch Info icon to display Info screen.

® N o v oA

Touch Back to return to Test/Home.

A New Test Resuits
RX Power Link Loss | Link ORL
W0 nm [ | 15501577 | 1650 LJ| 1650 4

-45.8 em | -84 wm | 20 | 43 5
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15100 Good connector.
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1650 nm Loss: 010 dB|Reflectance:

= Test/Home Menu




Fault Locate Setup Screen Overview
1. Fault Locate Setup screen is accessed from the Test screen by touching the TS100 Tool icon.
2. When in Fault Locate Setup screen, select a Test Setting to edit it
—Network Type
—Launch Cord
— Pass/Fail Rules
—Fiber Type
3. Press Start/Stop to initiate a test and return to Home screen.
4. Press Home/Menu or touch Back to return to Home/Test Results screen without starting a new test.
5. Touch dB/dBm icon to select Light Source & Power Meter test screen.

6. Touch Inspection icon to select Connector Inspection display screen.

A New Test 00:03
RX Power Link Loss | Link ORL Press
1490 nm  [€]| 155001577 [E | 1650 1650 }|.

<-50 s | <D0 gm | = B == dB | ToStart

Touch T8100, Launch Cable or Network to edit settings...
TS100
@ Network
R e

S, Fault Locate Setup

Network Type Launch Cord
L| Point-to-Point 150.00 m
@ |
—” PassfFail Rule Fiber Type
User G652 AIBICID
Press = to start Use Defaults




FleXpress® Fault Locate Test Setup

Network Type
Touch Network Type to view/edit the network type:
e FTTH PON through Splitter (Note: FTTH PON through Splitter is only available in TS100-70!)
—Touch current Splitter 1 Split Ratio to change it
» Point-to-Point/ PON to Splitter
o Touch Back to return to Test Setup

9, Fault Locate Setup 9, Fault Locate Setup 9, Fault Locate Setup

Network Type Launch Cord 43 Network Type 43 Network Type 43

6 ‘ Point-to-Point ‘ ‘ 150.00 m ‘ ‘ Point-to-Point ‘ ‘ FTTH PON ‘ ‘ Point-to-Point ‘ ‘ FTTH PON ‘
Pass/Fail Rule Fiber Type PON Splitter 1

User ‘ ‘ GE52.AIBICID ‘ ”dg: } oLt

Press - to start Use Defaults

‘ 1:2 H 2:2 H 1:4 H 2:4 ‘
‘ 1:8 H 2:8 H 1:16 H 2:16 ‘
‘ 1:32 H 2:32 H 1:64 H 2:64 ‘

Launch Cord

Touching Launch Cord option displays the Launch Cord Setup screen that allows the user to View / Edit Launch
Cable Length:

1. Touch Clear to clear current launch cable length

2. Enter desired launch cable length

3. Touch Cancel or Back to return to previous screen without saving changes
4

. Touch Done to save changes and return to previous setup screen

9, Launch Cord

1 2 3
4 5 6
7 8 9
. x Gancel v" Done
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Pass/Fail Rule

» Touch Pass/Fail Rule option to select ITU G.671, TIA-568.3-D, or User pass/fail rules.
» Touch and hold selected Pass/Fail rule to view/edit link and event pass/fail limits.

» Use left/right arrows to navigate through, view and edit pass/fail limits.

Notes:

1. Splice, Connector and Splitter pass/fail limits are fixed and cannot be edited for ITU G.671 and TIA-568.3-D
standards.

2. Splitter pass/fail limits can only be viewed and set in TS100-70.

9, Fault Locate Setup

e
D)

Network Type Launch Cord
Point-to-Point 150.00 m
PassiFail Rule Fiber Type
Cﬁ User (.652.A/BICID oo
Press = to start Use Defaults
o




Fiber Type

Fiber Type settings depends on the selected Network Type option. Touch the Fiber Type field to display one of the
following:

« Single-mode G.65x
e User-SMF options

Viewing and Configuring Fiber Type
G.65x Fiber Settings may be viewed but NOT changed.
User Settings may be viewed and changed.

To view G.65x Fiber Settings
» While in the Setup screen, make sure G.65x fiber type is displayed in the Fiber Type field.

« If not, touch the Fiber Type field to display the Fiber Type menu and touch the desired G.65x fiber types to
select.

» When back in the Setup screen, touch and hold the displayed G.65x fiber type to open and view the default
settings as follows:

—Group Index of Refraction (GIR)

—Backscatter Coefficient (BC)

—Fiber Attenuation (ACI; Loss-per-Distance)
» Touch Back to return to the Setup screen.

To view and edit User Fiber Type Settings
» While in the Setup screen, make sure the User Fiber Type label is displayed in the Fiber Type field.
« If not, touch the Fiber Type field to display the Fiber Type menu and touch the User option to select.

» When back in the Setup screen, touch and hold the displayed User label to open the User Fiber Type settings
screen and configure settings as follows:

—Group Index of Refraction (GIR)
—Backscatter Coefficient (BC)
—Fiber Attenuation (ACI; Loss-per-Distance)
» Touch the desired parameter field (e.g. GIR @1310 nm) to display its Editor screen.

« Edit the value using on-screen controls. Touch Done to save changes and return to the User Fiber Type settings
screen.

» Touch Back to return to the Setup screen.

9, Fiber Type Er =3 GIR @ 1650 nm

el 5 B o

3
‘ G652.A/BICID ‘ ‘ G653.A/B (IEC B2) ‘ D 14680 E E . 13000 .. 17000
Clear <{x]
‘ G654BIC (EC Bl.2_bic) ‘ G.655.CIDIE (IEC B4_cidie) BC @ 1650 nm E B II‘ <«
830 dB 7
‘ 6,656 (IEC BS) ‘ ‘ G657 AA2 (EG B6_alla2) ->
c ACI @ 1650 nm
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General Settings

General Settings screen is accessed from the Test Results Screen, by pressing Home/Menu button and then

selecting General Settings.
While in the General Settings screen:

» Touch the desired setting field (e.g. Language) to display a sub-menu.

» Touch Left / Right Arrows to display additional General Settings screen.

o Touch Back to return to the previous menu.

= TestiHome Menu £} Settings - General £ Settings - General
9 & Language [ Date and Time 9 Auto Off Timer Launch Quality Check
B Save As.. o General Settings
English 2020.09.19 08:47 ‘ 16 nin ‘ O
‘ e Send To ‘ ‘ E My Projects ‘ Distance Units 0 Bluetooth « Remote Control Received Image
] >
(] Speaker volume () Sereen hrightness » Switch Mode Auto-Save & Send
o ‘ 50 % ‘ ‘ 60 % ‘ Auto ‘ ‘ Disabled

While in the General Settings screen, select and view or edit settings as follows:
Language: touch to select from available languages (depends on installed language pack).
Distance Units: select

—kilometers

—meters

—kilofeet

- feet

—miles

Date & Time: touch to adjust current date or time
e Enable / Disable 24 hour format.
e Touch current Date & Time to edit.

—From the displayed sub-menu, touch the desired Time/Date parameter to enable it: hours, minutes, AM/PM (if
24-hour format disabled), year, month, day.

—Use [-] / [+] controls to change (increment or decrement) the selected parameter value.
—Touch Done to save changes and return to the General Settings screen.
—Touch Cancel or Back & to return to Settings menu without saving edits.

52 Date and Time

Time
:

Date

‘2020 ‘ ‘ 11 (November) ‘ ‘ 24 ‘

o | [ [ [ o |




Bluetooth: Touch to display a sub-screen and enable Bluetooth.

» Enable Bluetooth, touch the on/off control

« Select Search to discover devices, then select device from list to pair

Auto Off Timer: Touch to display a sub-screen and select Auto Off option: Never, 5 min, 15 min.

X Auto Off Timer

- | - g

Speaker Volume:

« If disabled, touch the on/off control to turn the Speaker on.

» Touch and/or touch and drag the adjustment slider right/left to increase/decrease the Speaker volume.
* Or, press [-] / [+] controls for precise adjustments of 10% by step.

» Press Done to save changes and return to the General Settings screen.

uj| Speaker volume

@ Speaker O

o | [ [ [V

50 %

Screen Brightness and Auto-dim:
» Touch the on/off control to enable/disable the Auto Brightness feature.

» When the Auto Brightness feature is disabled, you may adjust Brightness by touching and/or touching and
dragging the adjustment slider right/left to increase/decrease the Brightness value. Or, you may press the [-] and
[+] controls for precise adjustments of 10% by step.

» When the Auto Brightness feature is enabled, you may adjust several parameters:

—Auto-dim: Select Sleep icon and adjust slider right/left or use [+] / [-] controls to increase or decrease backlight
dim setting

- Brightness: Select Bright icon and adjust slider right/ left or use [+] / [-] controls to increase or decrease
brightness

—Timer control: Select and adjust time delay after last touchscreen action before display auto dims (if Auto
Brightness enabled)

—Press Done to save changes and return to the General Settings screen.

@ Screen hrightness

Auto Brightness ‘D

Lo [ B3 [vom




Live Fiber Detection and Launch Quality Check

Launch Quality Check

An optional launch quality check enables users to detect dirty, damaged, poorly seated, or mismatched (UPC to
APC) connectors.

To perform the launch quality check:

» With the Launch Quality Check option enabled, initiate a new test.

e The FlexScan will assess the loss and reflectance at the optical port connection to the launch cord (fiber ring) or

fiber under test.

If excess loss or reflectance is detected, the TS100 displays the ‘Launch Quality is Poor’ warning screen. From this
screen the user may chose to perform one of the following:

—Cancel a test by touching either Cancel or Back &
—Clean connectors, then repeat the launch quality check by touching Re-check.
— Continue testing without checking and cleaning the connection by pressing Continue.

Note: Testing a fiber with poor launch quality may produce poor test results.

Launch Quality Check

Launch quality is Poor

Are OMT and fiber connectors clean?

Are they the same type (UPC or APC)?

Cancel ‘ ‘ Re-check ‘ ‘ Continue

Live PON Test

Test Sequence in Live PON Test

Press Start/Stop to check Live Fiber and allow the user to configure test setup

—Live Power levels measured and optionally compared against pass/fail limits

—Touch TS100 Tool icon to configure Test Settings or select OLS/OPM or Inspection

—Touch Launch Cable Length to edit LC length

—Touch Network Configuration to edit Network Type: Pt-to-Pt or FTTH PON and Split Ratio
—Press Start/Stop again to initiate a test

« Touching [Press To Start] will also initiate a test

—Press Start/Stop to end a test

—Link Length, Loss, ORL detected and measured in 3-5 seconds

—Test continues to locate, identify and measure events

—Test completes within 30 seconds, identifying faults with loss or reflectance exceeding maximum allowed levels

e Touch LinkMap to view LinkMap details for most recent test

Press Home/Menu to select Save/Send or General Settings

4 New Test Resuits
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LinkMap Display and Navigation

Notes:
» The LinkMap Display automatically selects first fault when LinkMap first selected after test is complete.
» The LinkMap Display returns to previously selected event if LinkMap previously selected for this test.

When in LinkMap Display, you may perform the following operations:
1. Touch any LinkMap Icon to select it.
2. Touch Left or Right arrows to move to previous or next LinkMap event.

o Shift LinkMap left or right when left/right arrow pressed and previous or more off-screen events available to
view.

3. Touch Menu to save results and/or send to a Bluetooth-paired iOS or Android device running the FlexScan App.
» Note: Results must be saved before they can be sent to a paired device.

4. Touch Back to return to Test/Home screen.

4 New Test Results

K

A
1. Start; Connector @ 0.00 ft
Good connector.

[
1650 nm Loss: 010 dB|Reflectance: '52




Light Source and Power Meter Operation

Light Source Settings and Features

1.
2.

3.

Touch Laser On/Off to enable/disable light source. RED Laser indicates that source is ON.
Touch Modulation field to select source modulation: Wave ID, CW, Tone (270 Hz, 330 Hz, 1 kHz, 2 kHz).

—Select Wave ID mode for fastest loss measurements. While in this mode, the FlexScan source transmits
wavelength information, enabling a Wave ID power meter to synchronize and measure power at
received wavelength(s).

—Use CW mode to generate continuous wave light at a single wavelength for loss measurements with non-Wave
ID power meter.

— Generate Tone for fiber identification (270 Hz, 330 Hz, 1 kHz, 2 kHz).
Touch Wavelength field to select test wavelength.

Power Meter Settings and Features

4,

If used with non-Wave ID source, touch A to select wavelength. If used with Wave ID source, power meter
automatically synchronizes to and indicates received wavelength(s).

Touch and hold Ref/Set to store new reference(s) at received wavelength(s). Touch and release Ref/Set to view
stored reference(s).

Touch dB/dBm to toggle between power (dBm or Watts (mW, yW, nw)) and loss (dB) mode.

—Power meter detects and indicates fiber identifying tones when used with a light source capable of generating
a modulated Tone signal.

Notes:

7.

8.

Touch Menu to select Test/Home screen Menu.
— Allows user to Save or Send OPM results.
Touch Back to return to the previous screen.

3 OPM + OLS

dBidBm A 1310 nm Power : %

v 0,00

A

1650 nm
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Inspecting Fibers with FOCIS Probe and FlexScan

Optical connectors may be inspected using FOCIS Flex, FOCIS Duel, or FOCIS Lightning auto-focusing connector
inspection probe with IEC pass/fail analysis. Captured fiber end-face images and pass/fail results are immediately
displayed on the FOCIS probe display and on the paired FlexScan and may be saved in either FOCIS or FlexScan. A
micro-USB port on either FOCIS or FlexScan supports fast upload of internally stored results to PC.

Notes:

 For detailed instructions on how to operate FOCIS Flex, FOCIS Duel, or FOCIS Lightning inspection probe, please
refer to the FOCIS Flex, FOCIS Duel, or FOCIS Lightning User’s Guide (available on www.AFLglobal.com).

« In this User’s Guide, FOCIS Flex model is used as example in the following sections, which describe Bluetooth
pairing and inspection process.

FOCIS Flex Inspection Probe Overview

Controls and Interfaces

1. Power button.

2. Image Capture button.

F1 soft key (typically Back function).
F2 soft key (typically Select function).
Navigation and Edit functional keys.
Image Display - 2-inch Color LCD (320 x 240)
F1 and F2 soft key labels area.
Optical inspection port.

. Adapter tip.

10.Micro-USB port.

11.5 VDC input jack.

12.Charging indicator.

© PN VAW
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Pairing FlexScan with FOCIS Flex Inspection Probe

To transfer fiber-end images from the FOCIS Flex inspection probe and display inspection results on FlexScan, you
must Bluetooth pair your FOCIS Flex probe with FlexScan.

Enable Bluetooth on FlexScan

» From the Home screen, touch General Settings.

« In the General Settings screen, touch Bluetooth.
» Touch the Bluetooth On/Off control to enable.

= Test/Home Menu

£} Settings - General

& Language FH(O Date and Time 9 Huntooth rad O
‘ English ‘ ‘ 2020.09.19 0917

Distance Units Bluetooth « Device Name
m O g Paired with

1| Speaker volume Q Screen brightness »

‘ 50 % ‘ ‘ 60 %

$ Bluetooth

TS100-D4D0482A ‘

[

Enable Bluetooth on FOCIS Flex

Select to Set as Default Device.

From FOCIS probe Main Menu, select Settings, then press Select.

Highlight Pair with New Device, then press Select.

» Confirm Code displayed on FOCIS Flex by selecting Yes

» Confirm Code displayed on FlexScan by touching Done.

Bluctooth =
{:C‘)‘}Settings > Capture > Pair With New Device
ﬁ Results Manag@) Pass /Fail On @
Last Image > Bluetooth >
@Language > Display and Pow{':} >
ODevice Info > Beeper 0
This unit
Time & Date > FOCIS Flex2-6BECG708
Zoom Q) Is paired with

Pass Key 307612
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From the displayed Settings Menu, select Bluetooth, then press Select.

Device List

Main Tech Suppo

F5300-2032044
TAGON3?15

Set Default Connection
Rescan
Search More

o) Select

When a list of devices is displayed, navigate to and select Bluetooth ID of the FlexScan device, and then press

Device List
Main Tech Suppo
F5300-2032044

TAGON3716

Bluetooth pairing request
Confirm code:

307612

No

Yes

o)




Configuring Auto-Send
» From the Main Menu, select Settings.

« Select Capture to display the Capture settings screen.
« Highlight and Select Auto-Send.
» Use Arrow Keys to enable Auto-Send on 1st Capture key or on 2nd Capture key.

When Auto-Send is enabled, pressing Capture key from Live Image mode will initiate auto-focus (if enabled),
capture image, analyze pass/fail (if enabled), then send image and pass/fail results to paired FlexScan.

Main Menu 13:02 i
{@}Settings > Capture > I Auto Focus D
ﬁResults Manage@ > Pass/Fail &) an Auto-Send  On 1st Capture ©0n 1st Capture Key
Last Image > Bluetooth > Auto-Save Off OOn 2nd Capture Key
@Language > Display and Power Save > Save to Folder/File >
ODevice Info > Beeper D
Time & Date >
Zoom D

Inspecting Optical Connectors
Once FlexScan is paired to FOCIS Flex with Bluetooth enabled on both units, perform the following steps.
On FOCIS Flex:

« If testing an optical fiber connector, slide the ferrule of the optical fiber into the adapter tip installed on the
FOCIS Flex inspection port. Use caution not to contaminate the end-face of the fiber connector.

« If testing an optical fiber connector mounted in a bulkhead adapter, slide the adapter tip into the bulkhead
adapter.

« You will see a Live fiber-end image appears on the FOCIS Flex display.

« Capture the displayed image by pressing the Capture button. (Refer to section "FOCIS Flex Inspection Probe Overview"
on page 19).

« Once captured, the fiber end-face image is analyzed by the FOCIS Flex.

» Once analysis is done, inspection results will appear on the FOCIS Flex display.
» Simultaneously, FOCIS Flex will be sending results to the FlexScan paired to it.

Notes:
1. Touch left/right arrows to select image only, overlay only, or image + overlay
2. Touch Menu to select Test/Home screen Menu.
— Allows user to Save or Send OPM results, select General Settings, etc.
3. Press Back or Home button to return to the previous screen.

Q, Connector Inspection




File Manager

Fiber test results may be stored in the FlexScan internal memory or external USB stick. Saved test results are
organized into a Fiber Group sub-folder within a Project folder.
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The name of a saved result consists of several parameters, which are defined in the Save As screen.

4 p uUn

(@] 3 [P]

End 1_End 2_Cable_Fiber# Wavelength
Project:
‘ x Ganeel ‘ ‘Joaouuuou ‘ [Flber Group Name ] [Flber# ] $13 for 1310 nm
Endt: Endz:
‘ £ save To ‘ ‘END100 | ‘ENDZDO | S15 for 1550 nm
Cable: Fiber # M85 for 850 nm
‘ + Done ‘ ‘com ‘ ‘ 001 | M13 for 1300 nm

» Touch [Save To] to display File Manager and navigate to the desired Project / Fiber Group folder.
 Project, End 1, End 2, and Cable are user-defined in Text Editor.

» Fiber number auto-increments after each save, but can be modified in Number Editor as needed.
o Touch Done when finished.
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Manually Saving Results
e While in the Results view, touch Menu icon.
e Touch Save As.

« Edit Project, End1, End2, Cable and Fiber# names used to identify saved results: touch any field to edit it. Touch
Done when finished.

» Touch [Save To] to view, navigate and select destination memory, Project, or Fiber Group folder. Touch Back to
return to Save As screen.

e Touch Done to save test results.

ﬁ News Test Results

Project:
‘ ‘ JOB00000O ‘

Endt Endz:
‘ ‘END100 ‘ ‘ END200 |

2. Spiice @ 06102 km

Does not meet quality standards.
Re-splice.

Cable: Fiber #
‘ ‘0001 H o0l |

5]
1650 nin Loss: 017 dB|Reflectance: <'65.0 [ —

Saving to a Newly Created Folder
e While in the Results view, touch Menu icon.

» From the displayed sub-screen, touch Save As to display the Results Manager screen.

» Define Project, End1, End2, Cable and Fiber# fields used to name saved results. Touch Done when finished.

» Note: this will make the newly created Project, End1, End2, Cable, or Fiber current.

Saving to the Current Folder

« While in the Results view, touch the Menu icon.

» From the displayed sub-screen, touch Save As to display the Results Manager screen.

» Review Project, End1, End2, Cable and Fiber# names used to identify saved results. Touch Done when finished.

Auto-saving Results

TS100s may be configured to automatically save test results each time an OTDR test is completed. Auto-save (and
optional auto-send) are configured in the General Settings screen, as follows:

1. From the General Settings screen, touch the [Auto-Save & Send] control.
2. Select the desired auto-save/send option:
— Auto-saved Disabled: Results will not be automatically saved.

— Auto-save Only: Results will be saved using the configured Project, End1, End2, Cable and Fiber#. Fiber# will
be auto-incremented after each test completes and the results are saved.

—Auto-Save & Send: Results will be saved using the configured Project, End1, End2, Cable and Fiber#. Fiber#
will be auto-incremeanted after each test completes and the results are saved. Saved results will be sent to a
Bluetooth-paired Android or iOS device running the FlexScan App. If no device is paired, enabled and within
range, or if TS100's Bluetooth is disabled, results will not be sent or will timeout.

3. After selecting Auto-save Only or Auto-Save & Send, configure the Project, End1, End2, Cable and Fiber# as
described above.

23



Viewing Saved Test Results

To View Saved Test Results

o From the Test screen, press the Home/Menu button and then touch My Projects.

» Navigate through Project/Fiber Group/Fiber screens to locate the desired test record, then touch it to display it.
—Touch up/down keys to scroll up/down through list of files.
—Touch Folder Up icon t to navigate up to Fiber Groups or Projects level.

—Touch the Memory/USB icon to toggle between USB memory stick and internal memory card (if USB stick
present).

ﬂ Internal Memery, 98°% free
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Deleting Projects/Jobs/Fibers

e From the Test screen, press the Home/Menu button and then touch My Projects to display the Results Manager,
which may be displayed as Projects screen, Fiber Groups screen, or Fibers screen.

4 p Un

E NG

—Navigate through the Projects/Fibers screen to locate the desired results.
 Touch Files icon control to enable select function.
« Touch the files or folders you wish to delete.
« Touch the Menu soft key to display a sub-menu.
e Touch Delete.
e Then touch Done to confirm deletion.
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Transferring Results to a PC via USB

To transfer files from your FlexScan to a PC using a USB cable, perform the following:

« Connect your FlexScan to a PC using the supplied micro-USB to USB cable. Make sure the micro-plug is fully
seated in your FlexScan.

» Touch the USB soft key on the Results Scree.

e On your PC, open My Computer. A new removable drive named TS100 X: will appear, where ‘X:" is the drive
letter assigned to your FlexScan.

« Under TS100 X: you should see two folders: RESULTS and SOFTWARE.
» Copy the RESULTS folder to your PC.

—Under RESULTS you will see: TRACES.

—Under TRACES you will see all of the folders containing test results.
Note:

Before removing the USB cable connecting your FlexScan to your PC, or pressing the Cancel soft key on the USB
screen, left click the Safely Remove Hardware icon in the Start bar of your PC, then left click the Safely remove USB
Mass Storage Device — Drive (X:) message, where ‘X' is the drive letter assigned to your FlexScan.

Back Up Saved Results to USB Memory

To back up internally stored results to USB memory stick, plug external USB memory stick into FlexScan and
perform the following steps

o From the Test screen, press the Home/Menu button, and then touch My Projects

If Folder Up icon L is shown, touch it to navigate up to Projects level until L icon disappears.
« Verify that Internal Memory is currently selected - memory card icon is shown.

o If USB selected, touch USB memory icon to toggle to internal memory.

» Touch Menu icon.

» Touch Backup.

« Wait until “Writing backup to USB drive...” completes.
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How to View Device Information

FlexScan software revision, serial number, and calibration date can be viewed from the Device Information screen,
which is accessed from the Test/Home Menu screen.

» From any screen, press the Home/Menu button.

» From the displayed Test/Home Menu, touch Info.

» View FlexScan Info displayed on the Device Information screen:
—Model: Displays the Model Number of your FlexScan
—Device Software: Operating System and Application software
— Cal Date: FlexScan'’s calibration date
—Serial Number: FlexScan’s serial number
— Optical Software: Revision of current optical firmware
—Bluetooth Software: Revision of current Bluetooth firmware

= Test/Home Menu I Device Information
Model FH Cal Date 9
’7 TS100-60F-P2-W1-v1 ‘ ‘ 2020.08.25 ‘
Device Software Optical Software
125-ENG ‘ ‘ 1241 ‘
Serial Number ﬁ Bluetooth Software
o ‘ 2J33YK00005 ‘ ‘ 2M-161215D ‘ —

General Information

This user’s guide provides operating instructions for testing fiber optic networks with your FlexScan and assumes
that you have basic knowledge about testing fiber optic networks. The purpose of this user’s guide is to explain
how to use and maintain your FlexScan.

Please check our web site at www.AFLglobal.com, Test and Inspection for updates to this user’s guide and
additional application information.

Warranty Terms and Conditions

AFL products are warranted against defective material and workmanship for a period of (1) one year from the date
of delivery to the end user.

Any product that is found defective within the warranty period will, at the discretion of AFL, be repaired or
replaced. Warranty will be voided if the product has been repaired or altered by other than an authorized AFL
product repair facility, if the void sticker has been compromised, or which have been subject to misuse, negligence,
or accident.

In no case shall AFL liabilities exceed the original purchase price.

Need Help?
If you have questions regarding TS100 operation or reporting using TRM® 3.0, please contact Tech Support at
AFLtesttechsupport@AFLglobal.com
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